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Copyright and Trademarks 
Copyright © 1995, 2008, Oracle. All rights reserved. 

The Programs (which both the software and documentation) contain proprietary information; they 
are provided under a license agreement containing restrictions on use and disclosure and are also 
protected by copyright, patent, and other intellectual and industrial property laws. Reverse 
engineering, disassembly, or decompilation of the Programs, except to the extent required to obtain 
interoperability with other independently created software or as specified by law, is prohibited. 

The information contained in this document is subject to change without notice. If you find any 
problems in the documentation, please report them to us in writing. This document is not warranted 
to be error-free. Except as may be expressly permitted in your license agreement for these 
Programs, no part of these Programs may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, for any purpose. 

Oracle Data Integrator can be used for initial Oracle Agile PLM source to Oracle Agile PLM Data 
Mart target synchronizations. Oracle Data Integrator can be used for subsequent bulk loads and 
batch data transfers from Oracle Agile PLM source to Oracle Agile  PLM Data Mart target. 

If the Programs are delivered to the United States Government or anyone licensing or using the 
Programs on behalf of the United States Government, the following notice is applicable: 

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and 
technical data delivered to U.S. Government customers are "commercial computer software" or 
"commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-
specific supplemental regulations. As such, use, duplication, disclosure, modification, and 
adaptation of the Programs, including documentation and technical data, shall be subject to the 
licensing restrictions set forth in the applicable Oracle license agreement, and, to the extent 
applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software--
Restricted Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065. 

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other 
inherently dangerous applications. It shall be the licensee's responsibility to take all appropriate fail-
safe, backup, redundancy and other measures to ensure the safe use of such applications if the 
Programs are used for such purposes, and we disclaim liability for any damages caused by such 
use of the Programs. 

Oracle and Agile are registered trademarks of Oracle Corporation and/or its affiliates. Other names 
may be trademarks of their respective owners. 

The Programs may provide links to Web sites and access to content, products, and services from 
third parties. Oracle is not responsible for the availability of, or any content provided on, third-party 
Web sites. You bear all risks associated with the use of such content. If you choose to purchase 
any products or services from a third party, the relationship is directly between you and the third 
party. Oracle is not responsible for: (a) the quality of third-party products or services; or (b) fulfilling 
any of the terms of the agreement with the third party, including delivery of products or services and 
warranty obligations related to purchased products or services. Oracle is not responsible for any 
loss or damage of any sort that you may incur from dealing with any third party. 

ii Agile Product Lifecycle Management 

 

 



ACS User Guide  
 
 
 

 iii 

 

 

 

 

CONTENTS 
Copyright and Trademarks................................................................................................................... ii 

Working with Transfer Orders .......................................................................................... 1 
About Transfer Orders..........................................................................................................................1 
Transfer Order Object ..........................................................................................................................1 

Cover Page Tab .................................................................................................................................................................2 
Selected Content Tab.........................................................................................................................................................4 
Where Sent Tab .................................................................................................................................................................4 
Workflow Tab......................................................................................................................................................................6 
Attachments Tab ................................................................................................................................................................7 
History Tab .........................................................................................................................................................................7 

Creating Content Transfer Orders........................................................................................................7 
Creating a CTO with the Create Command........................................................................................................................7 

Deleting Transfer Orders....................................................................................................................12 
Printing Transfer Order Tabs..............................................................................................................12 
Agile Standard Reports for Transfer Orders ......................................................................................12 

IP Transfer Report ............................................................................................................................................................13 

Working with Packages .................................................................................................. 15 
What are Packages? ..........................................................................................................................15 
Intended Audience .............................................................................................................................16 
Package License Requirements.........................................................................................................16 
Who Uses Package Objects?.............................................................................................................16 
Viewing Packages ..............................................................................................................................16 

Package Tabs ..................................................................................................................................................................17 
Status of a Package .........................................................................................................................................................20 

Packages in Your Inbox .....................................................................................................................21 
Package Workflow..............................................................................................................................21 
Package Workflow Diagram...............................................................................................................23 
Partners and Content Managers ........................................................................................................25 

What Is a Partner?............................................................................................................................................................25 
What Is a Content Manager?............................................................................................................................................25 

Creating a Package............................................................................................................................25 



 

Creating a Package Object in Java Client ........................................................................................................................25 
Creating a Package Object in Web Client ........................................................................................................................26 

Submitting a Package ........................................................................................................................26 
Approving and Rejecting a Package ..................................................................................................26 
Importing Product Information from Package Attachments ...............................................................27 
Configuring Your Agile PLM System for Agile-to-Agile Communication............................................27 

After Accepting/Rejecting Package Objects.....................................................................................................................27 
About Searching for Packages...........................................................................................................28 
Final Status of Packages....................................................................................................................28 
Deleting Packages .............................................................................................................................29 

Undeleting Packages........................................................................................................................................................29 
  

iv Agile Product Lifecycle Management 

 



 

 v 

 

 

 

 

Preface 
The Oracle|Agile documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology 
Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html contains the 
latest versions of the Oracle|Agile PLM PDF files. You can view or download these manuals from 
the Web site, or you can ask your Agile administrator if there is an Oracle|Agile Documentation 
folder available on your network from which you can access the Oracle|Agile documentation (PDF) 
files. 

Note To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or later. 
This program can be downloaded from the Adobe Web site http://www.adobe.com. 

The Oracle Technology Network (OTN) Web site 
http://www.oracle.com/technology/documentation/agile.html can be accessed through Help > Manuals 
in both the Agile Web Client and the Agile Java Client. If you need additional assistance or 
information, please contact support http://www.oracle.com/agile/support.html 
(http://www.oracle.com/agile/support.html) for assistance. 

Note Before calling Agile Support about a problem with an Oracle|Agile PLM manual, please 
have the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Documentation Accessibility  

Our goal is to make Oracle products, services, and supporting documentation accessible, with good 
usability, to the disabled community. To that end, our documentation includes features that make 
information available to users of assistive technology. This documentation is available in HTML 
format, and contains markup to facilitate access by the disabled community. Accessibility standards 
will continue to evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be accessible to 
all of our customers. For more information, visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/ http://www.oracle.com/accessibility/.  

Readme 

Any last-minute information about Oracle|Agile PLM can be found in the Readme file on the Oracle 
Technology Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html
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Agile Training Aids 

Go to the Oracle University Web page 
http://www.oracle.com/education/chooser/selectcountry_new.html for more information on Agile 
Training offerings. 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

Accessibility of Links to External Web Sites in Documentation  

This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.  
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Chapter 1 

Working with Transfer Orders 

This chapter includes the following: 

 About Transfer Orders ......................................................................................................................................... 1 
 Transfer Order Object.......................................................................................................................................... 1 
 Creating Content Transfer Orders ....................................................................................................................... 7 
 Deleting Transfer Orders ..................................................................................................................................... 12 
 Printing Transfer Order Tabs ............................................................................................................................... 12 
 Agile Standard Reports for Transfer Orders ........................................................................................................ 12 

 
 

About Transfer Orders 
Transfer orders keep track of what, where, and when product content is transferred by Agile 
Content Service (ACS). There are two types of transfer orders: automated transfer order (ATO) and 
content transfer order (CTO). ATOs are created automatically by system-level subscribers that are 
configured by your Agile PLM administrator. CTOs are created when product content is published 
on demand by end users. 

Note You can create ATOs and CTOs only if your company has purchased an ACS 
server license and you have the appropriate roles and privileges. 

 

Transfer Order Object 
This section includes the following topics: 

 Cover Page Tab 

 Selected Content Tab 

 Where Sent Tab 

 Attachments Tab 

 Workflow Tab 

 History Tab 

When you view a transfer order, you are viewing a set of tabs on the Transfer Order window (Java 
Client) or page (Web Client). The following table lists the tabs for transfer orders and the section 
where each tab is described. 

Transfer  order  tab  name Tab in format ion  inc ludes 

Cover Page tab
 

General information about the transfer order. 
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Transfer  order  tab  name Tab in format ion  inc ludes 

Selected Content tab (on page 
4) 

 

Objects being transferred by the transfer order. 

Where Sent tab (on page 4) 
 

Delivery details about the transfer order and extraction. 

Workflow tab (on page 19) 
 

Where the transfer order is in the assigned workflow. 

Attachments tab (on page 7) 
 

Attached files. 

History tab (on page 7) 
 

Log of all actions taken on the transfer order. 

 
 

Cover Page Tab 

The  Cover Page tab has fields that contain the general information about the transfer order. Agile 
PLM automatically completes some of the fields; you complete the rest. 

To edit fields of an unreleased transfer order, click the Edit button. You may not be able to edit the 
contents of some fields. 

Note You cannot edit the Cover Page fields of an ATO. 
 

Fields on the Cover Page Tab 

By default, the Cover Page tab contains the fields listed in the following table. Agile PLM 
administrators can configure fields on the Cover Page tab. 

Note All fields are completed by Agile Content Service for ATOs. 

 

Field  Conta ins . . .  Completed. . .  

Transfer Order Type Displays CTO or ATO. Automatically or manually, when created. 

Transfer Order Number The number of the transfer order. Automatically or manually, when created. 

Description Text that describes the transfer order. The 
maximum length is set by the Agile PLM 
administrator. 

Manually for CTO; automatically for ATO. 
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Field  Conta ins . . .  Completed. . .  

Originator
or 

Subscriber

The user who created the CTO (can be selected 
from a drop-down list) or the subscriber of the 
ATO. 

Note: For CTOs, the roles assigned to the user 
listed in this field are the roles used to limit and 
define what data is extracted by the transfer 
order. For ATOs, roles are specified in the 
subscriber details. 

Automatically or manually, when created. 

Status Transfer order status; if no workflow has been 
selected, this field is Unassigned. 

Automatically, when created; updated as the 
transfer order moves through the assigned 
workflow. 

Workflow The name of the workflow being used to move 
this transfer order through the release process. 

Manually, whether one or more than one 
workflow applies. If more than one workflow 
applies to a CTO, the workflow selection can be 
changed as long as the CTO is in the Pending 
status type. Selecting the blank field in the 
Workflow drop-down list switches the CTO to the 
Unassigned status. For more information about 
workflows, see Getting Started with Agile PLM. 

Date Originated The date the transfer order is created. Automatically, when created. 

Date Released The date the transfer order is released. Automatically, when released. 

Final Complete Date The date the transfer order is completed. Automatically, when completed. 

 
 

Status on the Cover Page Tab 

Agile PLM uses a workflow stamp in the upper right corner of the Cover Page tab to indicate the 
status of a transfer order. Your Agile PLM administrator defines the name of each status in each 
workflow. 

Your Agile PLM administrator may have created customized workflows and statuses for your 
company. The table below shows only the default transfer order workflow statuses. 

Status name Status def in i t ion  

Unassigned No workflow has been assigned to this transfer order. The originator may still be developing the 
transfer order (CTOs only). No statuses are displayed on the Workflow tab. 

Pending The workflow has been assigned. The originator may still be developing the transfer order 
(CTOs only). It has not yet been approved or perhaps even completed. 

Review The transfer order is under review. It has not yet been approved or completed (Default CTOs 
workflow only). 

Released The transfer order is being processed by Agile Content Service. 

Complete Agile Content Service automatically moves a Released transfer order to Complete status after 
it is successfully processed. If a transfer order cannot be successfully processed, it remains in 
Released status, and an error appears on the Where Sent tab. 
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Note Do not modify any setting in the Released or Complete status in the default 
CTO workflow. Transfer orders extract data only while in Released status with 
enough time allowed for the extraction thread to process it. For more 
information about both CTO and ATO workflows, see the “Agile Content 
Service Settings” chapter of the Administrator  Guide.Note You can access the 
latest version of Agile manuals on the Agile Documentation Web site 
(http://docs.agile.com).   

The Workflow tab shows all the statuses the transfer order has been through, and the statuses 
remaining to complete the extraction process. (See “Workflow Tab (on page 19)” ) 

With appropriate privileges, you can switch a transfer order to another status with the Workflow tab 
or the Next Status button. 

Selected Content Tab 

The Selected Content tab lists the objects that are being transferred by the transfer order. You must 
have the required privileges to modify the Selected Content tab. 

 The Selected Content tab includes the following fields that are used to define what is extracted 
when the transfer order is processed: 

 Type — the type of the object. 

 Icons indicating the type of object, whether it has attachments, whether it has pending 
changes, and, if it is an item object, whether it has AML information on its Manufacturers tab. 

 Name/Number — the number assigned to the object. 

 Description — the description of the object. 

 tusLifecycle/Sta  — the current lifecycle phase or workflow status of the object. 

 Rev — the revision of the object to be transferred when the transfer order is released. 

 To view an object listed on the Selected Content tab, click its number. 

rmation of the transfer order. You must have the required 
privileges to modify the Where Sent tab. 

 

to 

 the latest released assembly. That EAI system would 

Where Sent Tab 

The Where Sent tab lists the transfer info

The Where Sent tab includes the following fields: 

Destination — where the transfer order is published. 

Agile PLM provides file, FTP, HTTP(S), JMS queue or JMS topic, and Agile system as 
destination types. For example, a content manager at an OEM uses Agile Content Service 
publish a CTO containing a released assembly to an EMS provider for quoting. That EMS 
provider may have set up an FTP site (destination) where the CTOs should be published. Or 
upon the release of an ECO, a content manager publishes a CTO to their EAI system to update 
the appropriate downstream systems with
be listed as the destination for the CTO. 

Page - 4 Agile Product Lifecycle Management 
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Destinations are defined by your Agile PLM administrator. For more information, see the 

 

the 

ted by your Agile PLM 

 

 transfer 

 

Administrator Guide. 

Filters — the extraction details for the transfer order. 

Filters determine what tabs are extracted for the objects listed on the Selected Content tab. 
Filters are grouped by base classes (for example, Change) and classes (for example, Change 
Orders). If a filter for a specific class includes a tab that is not visible, the tab is omitted from 
extracted data. For example, the Page Three tab of an ECO is not visible, but the filter for the 
Change Orders class allows you to extract Page Three tabs. When an ECO is extracted using 
this filter, the data on Page Three is skipped because it is not visible in the ECO subclass. 

Default filters are available for all objects. Additional filters are crea
administrator. For more information, see the Administrator Guide. 

Data Format/Data Extraction — the file type of the transfer file: aXML or PDX. 

Agile Extensible Markup Language (aXML) format is an XML representation of Agile PLM’s 
business schema. aXML contains all product content managed in Agile PLM. When the
order is published, a .ZIP file containing the aXML file and any attachments is created. 

Product Definition Exchange (PDX) packages are an industry-standard format for encoding
structured data in an XML format. Like aXML, a PDX package is also a zipped file with an 
attachment payload. The advantage of PDX is that it is an application independent way to 
describe product content. The disadvantage is that it may not support all Agile objects and 
data. For example, Price objects and price change orders (PCOs) cannot be exported in PDX 
format. For more information about PDX packages, see “Working with Packages (on page 15).” 

 attributes, for example, field and 

 
. To extract data for all sites, select All. 

 

 and is currently being transmitted to the 

re: the data extraction or transmission was not completed. 

failure, if one 

 
n accept or reject message to Agile PLM after the 

re 
 the Administrator Guide. 

 

Language — determines which language is used to label object 
column names. No language translation of data is performed. 

Site — one of the filters used to extract data. For example, if you select the Hong Kong site, 
only data visible for the Hong Kong site is extracted

 Date Sent — the date the transfer order is released. 

Transmission Status —the status of the transmission: 
 Pending: the transfer order is being processed. 
 Extracting: the data in the row (Selected Content and Filters) is currently being extracted 

into the specified file format. 
 Transmitting: the data was successfully extracted

specified destination. 
 Success: the data was successfully transmitted. 
 Failu

 Transmission Notes — the message describing the reason for the transmission 
occurs. 

Response — the acknowledgment of the transfer order by the remote system. 

A remote system or destination can relay a
expected data is received. Responses are defined by your Agile PLM administrator. For mo
information, see

Roles — (appears on the Where Sent tab of ATOs only) the roles used to extract data for this 
transfer order. 

For ATOs, roles are specified in the subscriber definition. Roles further fine tune and define the 
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data to be extracted. For example, if the roles selected do not allow a user to read 
manufacturer part objects, then manufacturer part object data will not be extracted even though 
manufacturer part objects appear on the Selected Content tab. The output file will contain a 

Note Note For CTOs, the roles used to extract data are defined by the roles assigned to the user who 

, only 

ing 

st reset the failed destination), the transfer 
orders are transmitted according to their order in the queue. This is done to maintain situations 

 da

Note 

section of content not readable by the role, but the details will display No Privilege. 

is listed in the Originator field in the Cover Page tab. 

If multiple transfer orders are being published to the same destination and that destination fails
the first transfer order’s Where Sent tab indicates the failure. The status of the remaining transfer 
orders does not change until the first transfer order is successfully transmitted. The remain
transfer orders are queued in the order they were scheduled to transmit. The Transmission Notes 
column indicates that the transfer order is waiting for another destination. Once the failed 
destination is reset (your Agile PLM administrator mu

where ta must be transmitted in sequential order. 

A transfer order is processed when it enters the Released status. Data extraction takes 
place at this time, not at the time the transfer order was created. Any changes to an object 
after the transfer order is created, but before the extraction process begins, are reflec
in the extracted content. For example, if an ECO is at the Revi

ted 
ew status when the transfer 

order is created, but the ECO is promoted to the Released status before the data is 
then the extracted status for the ECO is Released. extracted, 

 

Workflow Tab 

The Workflow tab shows where the transfer order is in the assigned workflow and lists present and 
e during each approval 

fer order. This can be an approver or an observer, 
. 

 nt Time — the date and time of the action. 

ng 

ctually approved or rejected the transfer order. 

 tab also includes a chart of the workflow, which shows all possible status names for 
the transfer order. The current status is highlighted. With appropriate privileges, you can use the 
Workflow tab to promote the transfer order manually. This information also appears on the History 
tab. 

past signoff information. It also shows all the approvals and rejections mad
cycle. 

The Signoff History table on the Workflow tab includes the following fields: 

 Reviewer — the user who reviewed the trans
and it can be a single user or a user group

 Action — y the reviewer.  the action taken b

 Required? — whether the reviewer is a required reviewer (approver) or not (observer). 

Local Clie

 Signoff Comments — any comments made by the reviewers (approvers and observers) duri
signoff. 

 Signoff User — the name of the user who a

 Status Changed By — the name of the user who switched the status. 

 Workflow Status — the name of the status. 

 Workflow — the name of the workflow that the transfer order is following. 

The Workflow
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Attachments Tab 

The Attachments tab of a CTO lists the files that have been attached to that transfer order. Attached 
files can be drawings or scanned images, documents, non-viewable files, compressed files, and so 
on. You can also point to a URL instead of a local attachment. 

For more information about attachments and the Attachments tab, see Getting Started with Agile 
PLM.

History Tab 

The History tab shows a summary of actions taken against the transfer order, including: 

 A description of the action 

 Which user took the action 

 The date and time of the action (local client time) 

 Details of the action 

 Comments made by users 

 Users notified 

 

ave a status type other than Unassigned or Pending before actions are recorded on the 
History

nts on 

Comm n the History tab can be made by anyone with sufficient privileges at any time. 

eason. In Java Client, you 
can d e-click a 

Note 

 The current status of the transfer order 

The next status of the transfer order 

While the transfer order status is Unassigned or Pending, the creation of the transfer order and any 
subclass modifications are recorded on the History tab, but no other actions are recorded. A transfer 
order must h

 tab. 

Comments on the History tab are different from the comments on the Workflow tab. Comme
the Workflow tab come from approvers and observers during the online approval process. 

ents o

The History tab shows some response information, such as the failure r
oubl row in the History table to see detailed information. 

If you do not have the appropriate Read privileges, you cannot view the fields 
on the History tab. If you have questions about your privileges, see your Agile 
PLM administrator. 

 

Creating Content Transfer Orders 
If you have the appropriate privileges, you can create or modify a CTO. 

rder type (subclass) and assign a number. Then you 

Creating a CTO with the Create Command 

When you create a CTO, you select the o
complete it by entering data on its tabs. 
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In Java Client, complete the fields on each tab. 

In Web Client, the Create Content Transfer Order wizard leads you through all the steps. 

For more information about creating transfer orders and other objects, see Getting Started with 
Agile PLM. 

Note Once the CTO is created, that CTO exists until you delete it. (See “Deleting 
Transfer Orders (on page 12)”.) 

 

Creating a CTO in Java Client 

To create a CTO in Java Client: 

1.  Click the New Object button . 

2. the supplied autonumber, or 

3.  On the tab, enter a description and select a workflow. The Default CTOs workflow is 
me

Note 

 In the New dialog box, select the appropriate CTO subclass. Use 
enter a number. Click OK. 

The CTO is created and displayed with the Cover Page tab on top. 

Cover Page 
recom nded. When you have finished, click Save. 

The roles applied when object data is extracted are determined by the roles 
assigned to the user listed in the Originator field on the Cover Page tab of the 
CTO. 

For example, if the originator user does not have the necessary privileges to view items 
assigned to the Libra product line, when BOM items are extracted, any product line Libra 
items will be not be extracted. 

In a similar manner, 
Kong BOM data will not be

if the originator user is not assigned to the Hong Kong site, Hong 
en if Hong Kong is selected in the Site column on  extracted, ev

the Destinations tab. 

Selected Content Add4.   On the  tab, click   to search for objects you want to transfer. Select the 
objects in the search results and click OK. 

 If any of the selected objects are items or prices, you must select a revision for each item or 
price you have selected. In the Select Revisions dialog box, select an item in the left pane. In 

5. 

 

ns for each item, click OK. The objects are added to 

6. 

the right pane, select the item revision you want. By default, the most recent released revision
is selected, but you may select a different revision. 

When you have finished selecting revisio
the Selected Content table. 

 On the Where Sent tab, click Add  to add a destin
destinations. (See 

ation for the transfer. You can add multiple 
Where Sent Tab (on page 4).) 

 From the on drop st, select a destination. Destinations are created and 
ad

 

In the Add dialog box, select the following: 
Destinati -down li

defined by your Agile PLM ministrator. 

In the Filters field, click the  button to open the Filters dialog box. Select as many filters 
as you need. Your Agile PLM administrator defines the filters used on your Agile PLM 
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system. If you have questions about which filters to use, ask your Agile PLM administra

You need at least one filter for each type of object type on the Selected Content table of 
the CTO. On your Agile PLM system, there may be multiple filters for the same object 
class, each with a different name and definition. Depending on how the filter is defined, 
Agile ACS may extract only the table information visible on a tab, or Agile ACS may extrac
the information visible in the table and also the objects listed in the table. For example, a
filter for items may include the option for the 

tor. 

t 
 

ab of Tab and Items, All Levels. In this 
ts 

e whether the AML information on an item’s 

he Selected 
ts. 

ele tails about these formats, see 

BOM t
example, when an item on the CTO Selected Content tab is extracted, all the items on i
BOM, through all BOM levels, are also extracted. 

In a similar manner, a filter can determin
Manufacturers tab is extracted. In that case, you must also select a filter for manufacturer 
part objects and manufacturer objects. 

Each type of object extracted needs a filter, whether the object type is listed on t
Content tab of the CTO or the object type is referenced on the tabs of the selected objec

For details about filters, see the chapter “Agile Content Service Settings” in the 
Administrator Guide. For details about filters used in your Agile PLM system, ask your 
Agile PLM administrator. 

 S ct a data extraction format, either aXML or PDX. For de
Where Sent Tab (on page 4). 

 Note Note Price objects cannot be exported in PDX format. 

 Select a language. For details about the language setting, see Where Sent Tab (on page 
4). 

 In the Site field, select All, or select one site. For example, if you select the Hong Kong site, 
le to the Hong Kong site will be extracted. 

When you are finished, click OK. 

1. 

e 

3. flow. 
The Defa

Note

only object data that is visib
 

 

Creating a CTO in Web Client 

To create a CTO in Web Client: 

 In the toolbar, choose Create > Transfer Order. 
2.  In the Create Content Transfer Orders wizard step, select the appropriate CTO subclass. Us

the supplied autonumber, or enter a number. Click Continue. 

 In the Enter Cover Page Information wizard step, enter a description and select a work
ult CTOs workflow is recommended. When you have finished, click Next. 

 The roles applied when object data is extracted are determined by the roles 
assigned to the user listed in the Originator field on the Cover Page tab of the 
CTO. 

For example, if the originator user does not have the necessary privileges to view items 
assigned to the Libra product line, when BOM items are extracted, any product line Libra 
items will be not be extracted. 

In a similar manner, if the originator user does is not assigned to the Hong Kong site, Hon
Kong BOM data will not be extracted, even if Hong Kong is selected in the Site column on
the 

g 
 

4. h for objects you want to transfer. 
k Next. 

Destinations tab. 

 In the Add Selected Content wizard step, click Add to searc
In the Select Objects window, select the objects in the search results, and clic
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The objects are added to the Add Selected Content table. 

When you have completed the Add Selected Content wizard step, click Next. 
5. add  In the Add Where Sent wizard step, click Add to add a destination for the transfer. You can 

multiple destinations. (See Where Sent Tab (on page 4).) 

stinations and Filters to Content TraIn the Add De nsfer Order window, select the following: 

 ck the 

 From the Destination drop-down list, select a destination. Destinations are created and 
defined by your Agile PLM administrator. 

In the Filters field, cli  button to open the filter selection window. Select as many 
 

act 
ects listed in the table. For example, a 

this 

cted 
ts. 

s about filters used in your Agile PLM system, ask your 

  about these formats, see 

filters as you need, and click OK. Your Agile PLM administrator defines the filters used on
your Agile PLM system. If you have questions about which filters to use, ask your Agile 
PLM administrator. 

You need at least one filter for each type of object type on the Selected Content table of 
the CTO. On your Agile PLM system, there may be multiple filters for the same object 
class, each with a different name and definition. Depending on how the filter is defined, 
Agile ACS may extract only the table information visible on a tab, or Agile ACS may extr
the information visible in the table and also the obj
filter for items may include the option for the BOM tab of Tab and Items, All Levels. In 
example, when an item on the CTO Selected Content tab is extracted, all the items on its 
BOM, through all BOM levels, are also extracted. 

In a similar manner, a filter can determine whether the AML information on an item’s 
Manufacturers tab is extracted. In that case, you must also select a filter for manufacturer 
part objects and manufacturer objects. 

Each type of object extracted needs a filter, whether the object type is listed on the Sele
Content tab of the CTO or the object type is referenced on the tabs of the selected objec

For details about filters, see the chapter “Agile Content Service Settings” in the 
Administrator Guide. For detail
Agile PLM administrator. 
Select a data extraction format, either aXML or PDX. For details
Where Sent Tab (on page 4). 

Note Note Price objects cannot be exported in PDX format. 

 ent TabSelect a language. For details about the language setting, see Where S  (on page 

t the Hong Kong site, 

Using the Save As feature is a quick way to create a new CTO that is very similar to an existing 
CTO or ATO. This feature is also a good way to resend data previously sent in an ATO. 

4). 
 In the Site field, select All, or select one site. For example, if you selec

only object data that is visible to the Hong Kong site will be extracted. 
 When you are finished, click Add. 

6.  When you have completed the Add Where Sent wizard step, click Finish. 
 

Creating a CTO Using the Save As Feature 
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Note If you do not have Discovery and Read privileges for any of the objects on the 
Selected Content tab of the existing transfer order, an error message appears. 
You can either cancel the CTO creation process or you can continue. If you 
choose to continue, the CTO is created, however, on the Selected Content tab 
some objects rows in the table are missing due to insufficient user privileges 
(no Discovery and Read privileges for those objects). The missing objects are 
not extracted when the CTO is processed. For more information about user 
roles and CTO processing, see the chapter about configuring ACS in the 
Administrator Guide. 

 

Modifying Fields 

With sufficient privileges, you can modify editable fields. You can modify only fields that have been 
made editable by the Agile PLM administrator. 

You cannot manually enter information on the Workflow or History tabs; Agile PLM automatically 
completes these. 

Note After a CTO has reached the Released status, it is processed by Agile Content 
Service, but you can still modify the Description field. 

The CTO page opens with the Cover Page tab on top. 

To modify a CTO in Java Client: 

1.  Complete or change the appropriate fields on the Cover Page tab. Click Save when you finish 
editing the Cover Page tab. 

2.  On the Selected Content tab: 

 To add objects, click the Add button , and follow the steps to search for and select the 
objects you want. 

 To remove objects, select and highlight the row you want to remove, and click the Remove 
button . 

 To select a different revision of an object, delete the object’s row and add the object again, 
selecting a different revision. 

3.  On the Where Sent tab: 

 To add destinations, click the Add button , complete the dialog box, and click OK. 
 To edit a destination and its filters, click the row you want to select it, and click the Edit 

button . In the dialog box, change the fields you want to edit, and click OK. 
 To remove a destination, click the row you want to select it, and click the Remove button . 

To modify a CTO in Web Client: 

1.  On the Cover Page tab, click Edit, and complete or change the appropriate fields. Click Save 
when you finish editing the Cover Page tab. 

2.  On the Selected Content tab: 
 To add objects, click Add, and follow the wizard steps to search for and select the objects 

you want to add. 
 To remove objects, check the rows of the objects you want to remove, and click Remove. 
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3.  On the Where Sent tab: 
 To add destinations, click Add. Complete the information in the window. 
 To edit destinations and filters, check the rows you want to edit, and click Edit. Click Save 

when you have finished editing the destinations and filters. 
 To remove destinations, check the rows of the destinations you want to remove, and click 

Remove. 
 

Deleting Transfer Orders 
You can delete unreleased transfer orders. Agile PLM supports “soft” and “hard” deletes. 

Note You can undelete a soft-deleted object. You cannot undelete a hard deleted 
object. 

You can delete only transfer orders that meet the following criteria: 

 You created it, or Agile PLM administrator has given you the appropriate privileges to delete a 
transfer order. 

 The transfer order is at the Pending status type or the Unassigned status. 

 The transfer order has failed to reach its Destination. 
 

Printing Transfer Order Tabs 

In Java Client, click the Print drop-down list button  and select All Tabs or select the tab you 
want to print. The print preview dialog box opens. When you are ready, in the dialog box, click Print 

. 

In Web Client, you can print transfer order tabs from your Web browser. With the transfer order 
open, choose Actions > Print. You can print the current tab or all tabs. Attachments are printed from 
their native applications or the Agile Viewer. 

For more information about printing, see Getting Started with Agile PLM. 

Agile Standard Reports for Transfer Orders 
For detailed information about using all types of Agile reports, see the “Working with Agile Reports” 
chapter in Getting Started, which includes information about: 

ports 

 privileges affect reports 

 Standard reports, custom reports, and external re

 How your roles and

 Report object tabs 

 Creating and modifying report layouts 

 Creating custom and external reports 
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 Running, scheduling, saving, and deleting reports 

 

fer orders. This report lists the objects 
nd when they were sent. 

u

1. ort in the Reports > Standard Reports > Process Reports 

 Report output window
 

IP Transfer Report 

The IP Transfer Report is the Agile standard report for trans
sent to a given destination a

To r n the IP Transfer report: 

Analytics and  Select the IP Transfer rep
folder. The IP Transfer Report page appears. 

2.  Click the  Execute button. The Select Date Range and Destination page appears. 

 Select the start date and end date of the time period you want to the rep3. ort to cover. This 
defines the time range in which transfer orders were sent. 

4.  Click  next to the  field and selDestination ect the destinations you want to include from the 

.  Click Finish to display the report. 

Available Values list. 

5

 

Defaul t  IP  Transfer  report  layout  f ie lds  Descr ipt ion 

Object Number The number of the object that was sent, for example, an item number or 
a change number. 

Object Type The type (subclass) of object, for example, part type Resistor or change 
order type ECO. 

Description Description of the object that appears in the object’s Description field. 

Date Sent The date the transfer order 
the destination you selected

was processed and the object was sent to 
 in the report wizard. 

TO Number The transfer order number. 
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Working with Packages 

This chapter includes the following: 

 What are Packages? ........................................................................................................................................... 15 
 Intended Audience............................................................................................................................................... 16 
 Package License Requirements .......................................................................................................................... 16 
 Who Uses Package Objects? .............................................................................................................................. 16 
 Viewing Packages ............................................................................................................................................... 16 
 Packages in Your Inbox....................................................................................................................................... 21 
 Package Workflow ............................................................................................................................................... 21 
 Package Workflow Diagram ................................................................................................................................ 23 
 Partners and Content Managers.......................................................................................................................... 25 
 Creating a Package ............................................................................................................................................. 25 
 Submitting a Package.......................................................................................................................................... 26 
 Approving and Rejecting a Package.................................................................................................................... 26 
 Importing Product Information from Package Attachments ................................................................................. 27 
 Configuring Your Agile PLM System for Agile-to-Agile Communication.............................................................. 27 
 About Searching for Packages ............................................................................................................................ 28 
 Final Status of Packages ..................................................................................................................................... 28 
 Deleting Packages............................................................................................................................................... 29 

 
 

What are Packages? 
You can use packages to track, control, and route incoming product content. 

Agile PLM packages may be created manually by supply chain partner users. More typically, Agile 
Content Service  (ACS) is used to initiate automatic Agile-to-Agile communication. Product data can 
be sent to your Agile PLM system from another Agile PLM system. The target or receiving Agile 
PLM system automatically creates a package object, attaches the data files, and submits the 
package. 

Product data can describe a proposed product. Product data may be files and documents attached 
to the package object. However, ACS allows product data (Agile PLM objects) to be extracted into a 
PDX or aXML file, which is attached to the package object. The PDX or aXML files can be imported 
into the target or receiving Agile PLM system, thus creating the appropriate Agile PLM objects on 
the target Agile PLM system. The files are accessed through the Attachments tab of the package. 

Note For detailed information about Agile Content Service, see the Administrator 
Guide. 

Agile PLM packages are routable objects. They have workflows that determine the sequence of 
statuses they follow as they go through the approval cycle. 

A package is different from other Agile PLM objects because it has no relationship to any other 
Agile PLM object. It does not have a revision level, you cannot write changes against it, it has no 
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Manufacturers tab, and it has no BOM. 

In the same way that the change classes include the subclasses ECO, ECR, and MCO, the 
Package class may include subclasses in addition to the out-of-the-box Package subclass if your 
Agile PLM administrator has created them. 

If package attachments include PDX, aXML or comma-delimited text files describing Agile PLM 
objects, the information can be imported directly from the Attachments tab of the released (accepted) 
package once the package is released. 

Intended Audience 
This chapter assumes that you are a Product Collaboration user who works with Agile PLM 
package objects. You may be a user who creates and submits packages, an approver or an 
observer of packages that are routed for approval, or a content manager, who is like a change 
analyst who works with packages. The package objects you work with may be created by users 
who are supply chain partners, or the package objects may be created automatically by Agile 
Content Service (ACS). 

Package License Requirements 
Agile PLM package objects are provided with the basic Agile Product Collaboration server license, 
which allows any user, with the appropriate assigned privileges, to create, use, and search for 
package objects. 

Agile-to-Agile communication is provided by the ACS server license. The ACS license allows the 
Agile PLM administrator to define the details of the automatic package object generation process. 
(For more information, see the Administrator Guide.) 

Who Uses Package Objects? 
Agile PLM packages are available to users with the appropriate roles and privileges. The content 
manager uses Agile Java Client or Agile Web Client to oversee the routing and approval of 
packages. Supply chain partners can create and submit packages or use Agile Content Service 
(ACS) to submit them automatically. 

ACS provides automatic Agile-to-Agile communication, which sends Agile PLM data from one Agile 
PLM system to another. The destination or receiving Agile PLM system automatically creates 
package objects that include the data files on the Attachments tab. The Agile PLM administrator of 
the destination Agile PLM system defines the details of the automatic package object generation 
process. (For more information, see the Administrator Guide.) Once the package object is 
automatically created and submitted, the approval and routing procedures are the same as for any 
other routable object. 

Viewing Packages 
This section contains the following topics: 
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 Package Tabs 

 Status of a Package 
 

Package Tabs 

Like any other Agile PLM object, a package object is displayed with tabs. This section contains the 
following topics: 

 Cover Page Tab 

 Workflow Tab 

 Attachments Tab 

 History Tab 

The followi  tabs for Agile PLM packagng table lists the es. 

Package tab  name Tab in format ion  inc ludes 

Cover Page (see "Cover 
Page Tab" on page 17) 

General information about the package. 

Source GUID, XFER Order Locator, and Response Expected are optional fields used by Agile 
ACS. 

Workflow (see "Workflow 
" on page 19) Tab

Where the package is in the assigned workflow. Signoff approvers and observers, and the results 
of their reviewing of the package. 

Attachments (see 
"Attachments Tab" on 
page 19) 

Attached files. Content from PDX, aXML and CSV files can be imported from the Attachments 
tab to the Agile PLM database. 

For information about importing package attachment data into the Agile PLM database, see 
Importing Product Information from Package Attachments (on page 27). 

History (see "Attachments 
Tab" on page 19) 

Shows actions taken on the package—for example, when attachments were added and 
removed. 

 

Note Your Agile PLM administrator may have added additional Page Two and Page 
Three tabs, which contain custom fields defined by the administrator. 

 

Cover Page Tab 

The package Cover Page tab includes some basic information about the proposed product. The files 
and images describing the proposed product are included on the Attachments tab. The attachments 
might include specifications, schematics, assembly drawings, test procedures, or any other file type 
requi ager routes ugh workflow. red. The content man  a package for review thro

Cover  Page 
f ie ld  

Completed  Conta ins  

Package Number Usually automatically; may be an autonumber or a 
manually entered number. 

Package number assigned to the package when 
it is created. 
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Cover  Page 
f ie ld  

Completed  Conta ins  

Status Automatically, when created; updated as package 
moves through the assigned workflow. 

The status of the package. See Status of a 
Package (see "Final Status of Packages" on 
page 28). If no workflow is selected, this field is 
Unassigned. 

Originator Usually manually, but may contain a default. The user who created the package (can be 
selected from a drop-down list). 

Partner Name Usually manually, but may contain a default. The partner (generally, a company) to which the 
Originator is assigned. 

Date Originated Usually automatically, when created (with default set 
by the Agile PLM administrator). 

The date the package was created. 

Date Released Automatically. Date the package was released, or accepted. 

Assembly Number Manually. Number of the proposed assembly. 

Assembly 
Revision

Manually. Revision of the proposed assembly. 

Description Manually, but can contain a default defined by the 
Agile administrator. 

Up to 1023 characters, including spaces and 
carriage returns (which count as two spaces). 

ECO Number Manually. An ECO number associated with the assembly. 

Package Type Usually manually, but may contain a default. Drop-down list of package types defined by the 
Agile PLM administrator. 

Program Manager
(may also be called 
Content Manager) 

Automatically when package changes from pending to 
submit status. 

Name of the content manager assigned to the 
partner in the Partner Name field. A content 
manager oversees the package routing process 
(similar to a change analyst). 

Category Manually The category of this package. A package cannot 
be changed to a Released workflow status 
unless the Category field and all other required 
fields have values. 

Workflow Manually, whether one or more than one workflow 
applies. If more than one workflow applies to a 
package, the workflow selection can be changed as 
long as the package is in the Pending status type. 
Selecting the blank field in the Workflow drop-down 
list switches the package to the Unassigned status. 

For more information about workflows, see Getting 
Started with Agile PLM. 

The name of the workflow being used to move 
the package through the approval process. 

Final Complete 
Date

Automatically. Date the package was switched to the Complete 
status type. 
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Cover  Page 
f ie ld  

Completed  Conta ins  

Source GUID Automatically. Required for Agile Content Service (ACS) tasks. 
Unique identifying code representing the source 
Agile PLM system when a package object is 
created by an Agile-to-Agile product content 
transfer. If ACS is not being used, this field may 
not be visible. See the Administrator Guide for 
details.  

XFER Order 
Locator

Automatically. Required for ACS tasks. Identifies the transfer 
order that created the package. If ACS is not 
being used, this field may not be visible. See the 
Administrator Guide for details.  

Response 
Expected

Automatically. Required for ACS tasks. Indicates whether the 
source Agile PLM system expects a response 
when the package is either accepted or 
rejected. If ACS is not being used, this field may 
not be visible. See the Administrator Guide for 
details.  

 
 

Workflow Tab 

The Workflow tab displays a flowchart of the statuses in the selected workflow. The Signoff History 
table on this tab list the users who are assigned to either approve or observe the proposed 
package, the actions taken by the approvers, the date and time of each action, and any comments 
made by the approvers and observers. The Workflow tab of a package is identical to the Workflow tab 
of a change. 

Either approvers and observers are automatically assigned by the workflow, or they are assigned 
when the content manager routes the package for approval. For details, see the “Routing Objects 
with Workflows” chapter in Getting Started with Agile PLM. 

Attachments Tab 

The Attachments tab lists the files and URLs that have been attached to the package. You can also 
import data into your Agile PLM system from text, PDX, aXML, or .CSV files attached to the 
package. 

For general information about working with attachments, see Getting Started with Agile PLM. 

For information about importing data from a package, see Importing Product Information from 
Package Attachments (on page 27). 

History Tab 

The History tab shows a summary of actions taken against the package, including a description of 
the action, which user took the action, the current status of the package, the next status, and other 
information. 

The types of actions recorded on the History tab are: 
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 Modify an attachment on the Attachments tab 

 Add or delete approvers 

 Approve and reject 

 Change a field, any tab 

 Change a status 

 Autopromotion fails 

ss 

s 

History tab can be made by anyone with sufficient privileges at any time. 

Status of a Package 

s of a package. Your 
rkflow. 

The  shows the Default Packages workfl

 Change a subcla

 Comment

 Send 

 Print 

Comments on the History tab are different from the comments on the Workflow tab. Comments on 
the Workflow tab come from approvers and observers when they perform the online approval 
process. Comments on the 

Each package has a status stamp in the top right corner to indicate the statu
Agile PLM administrator defines the name of each status in each wo

 following table ow statuses. 

Status name Status def in i t ion  

Unassigned 

(No status type) 

ator may still be developing the 
package. No statuses are displayed on the Workflow tab. 
No workflow has been assigned to this package. The origin

Pending 

atus type) 

 still be developing the package. The package has not been submitted to the 
content manager. 
The originator may

(Pending st

Submitted 

(Submit status type) 

The package has been submitted to the content manager. (If the content manager switches a 
submitted package to the Pending status, the originator can modify the package and submit it 
again.) 

Review 

atus type) 

The package has been routed for review through workflow. 

(Review st

Accepted 

d status type) 

The package has been signed off by the approvers and has been released. 

(Release

Closed 

lete status type) 

The package is no longer used. 

(Comp

Hold 

(Hold status type) 

The package has been placed on hold while the content manager gathers information. 
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Status name Status def in i t ion  

Canceled 

(Cancel status type) 

The package has bee
have rejected it. 

n canceled due to a fundamental flaw or because one or more approvers 

 
 

Packages in Your Inbox 
itted to you in the Agile PLM Inbox. You can view packages that have been subm

To view packages in the Inbox in Java Client: 

1.  Click the Inbox drop-down arrow . 

2.  Choose Workflow Routings from the list. 

3.  In the Inbox table, click the Workflow column header to sort the table by workflows. 

 click Home to display the welcome page. 

lay your Workflow Routings Inbox. 

kflows, just as changes may have custom workflows. 
. 

nies who use 

r

2. 

ge data is not complete, the 

4. 
 a Review status type, which routes the package for approval. 

6. 

7. 

ma-delimited text files describing Agile 
e Attachments tab. Package attachments 

To view packages in the Inbox in Web Client: 

1.  From the Web Client toolbar,

2.  Click Workflow Routings to disp

3.  In the table, click the Workflow column header to sort the table by workflows. 
 

Package Workflow 
Agile PLM packages may have custom wor
For details, see the “Routing Objects with Workflows” chapter in Getting Started with Agile PLM

Packages are created by partners. Typically, partners are customers at other compa
Agile PLM to create packages. 

He e is the typical workflow of a package: 

1. A partner at another company creates an Agile PLM package. 

 When the package is complete, the partner submits it to the content manager. 

3.  The content manager opens and reviews the package. If the packa
content manager may return the package to the partner for more information. 

 If the package is complete, the content manager switches it to the next status in the workflow. 
Typically, the next status is

5.  The approvers review the package and either accept it or reject it. 

 When the package is accepted by the approvers, depending on workflow settings, either the 
content manager accepts (releases) it, or it is autopromoted to the next status in the workflow 
and released (accepted). 

 The content manager processes the package data according to unique company-specific 
cpro edures. 

If the package includes PDX files, aXML files, or com
PLM objects, these may be imported from the packag

 Page - 21

  

 



ACS User Guide  
 
 
 

crea ication (through Agile ACS) can be either PDX files or aXML 

ne attached file. 
Clic

The impo ss begins. 

ted by Agile-to-Agile commun
files. 
a. On the package Attachments tab, select o
b.  k the Import button on the Attachments tab. 

rt proce
c.  Follow the onscreen instructions. 

Note For more information about the Import wizard, see the Import and Export 
Guide. 

8.  When th nd no longer used, the content manager closes it. e package is processed a

Note Your Agile PLM administrator may define custom workflows for packages. 
Custom workflows may have multiple Submit, Review, and Released status 
types. For details, see the “Routing Objects with Workflows” chapter in Getting 
Started with Agile PLM. 

The Package agramWorkflow Di  (on page 23) summarizes the typical workflow of an Agile PLM 
package, using the Default Packages workflow. 

Note The content manager is the user named in the Program Manager field on the 
Cover Page tab. Your Agile PLM administrator may have changed the name of 
this field. 
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Package Workflow Diagram 
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Partners and Content Managers 
The Agile PLM administrator assigns the Partner role or Content Manager role to the appropriate 
Agile PLM users. 

What Is a Partner? 

Partners are typically users at an EMS customer site who create Agile PLM packages of proposed 
products and submit them to your company for review and approval. However, a user in your 
company with the appropriate user license privileges may also create and submit packages. 

What Is a Content Manager? 

The Agile PLM administrator assigns specific partners to specific content managers. The role of a 
content manager is similar to that of a change analyst or component engineer. Content managers 
manage packages throughout their workflow. (In previous releases, the content manager was 
referred to as the program manager.) 

Creating a Package 
To create a package, you must have the appropriate privileges. 

Creating a Package Object in Java Client 

You can create a package with the File > New > Package command or the File > Save As command. 

The process for creating new objects involves two main steps: creating an empty object, then filling 
in the object tabs with information specific to the object. 

To create and complete a package: 

1.  Click the New Object button . 

2.  In the New dialog box, use the Type drop-down list to select the type (subclass) of package you 
want to create. 

3.  Assign a number to the package. To do so, either use the supplied autonumber, click the 
AutoNumber button , or type a number. 

The autonumber format and sequence are determined by your Agile PLM administrator. Your 
Agile PLM administrator also determines whether using autonumbers is required or optional. 

4.  Click OK. 

The new package appears with the Cover Page tab showing. 

5.  Fill in information on the package tabs, as desired. 

You do not enter information on the History tab. That tab is completed automatically. 
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Creating a Package Object in Web Client 

You can create a package with the Create > Package command or the Actions > Save As command. 

A wizard leads you through the process of creating a package and adding attachments. 

To create and complete a package: 

1.  Choose Create > Package. 

2.  Follow the onscreen instructions to complete the wizard. 

You do not enter information on the History tab. That tab is completed automatically. 

When you click the AutoNumber button to enter the package number, you might see a list of 
autonumber choices. The autonumber format and sequence are determined by your Agile PLM 
administrator. Your Agile PLM administrator also determines whether using autonumbers is 
required or optional. 

Submitting a Package 
You can submit an Agile PLM package using the same buttons and procedure you use to submit a 
change or other routable object (provided you have the appropriate privileges). For details, see the 
“Routing Objects with Workflows” chapter in Getting Started with Agile PLM. 

No matter which Agile PLM product was used to create the package, when a partner submits a 
package, the content manager is notified by email. 

The content manager can also use defined searches in the Searches | Content Manager Searches folder 
to find recently submitted packages. 

Using the same buttons and selections used to work with changes, the content manager can 
choose an action for the package, including: 

 Audit the package. 

 Return the package to the originator (partner) for more information. 

 Route the package for review to a list of approvers and observers. 

 Accept the package. 

 Cancel the package. 

See the Package Workflow Diagram (on page 23) for a summary of the default package workflow. 

Approving and Rejecting a Package 
Users on the approver and observer lists on the Workflow tab approve or reject a package the same 
way they would approve or reject a change. 

Approvers who do not respond to a package within the reminder period receive a reminder email, 
telling them that they have not yet approved or rejected the package. If the approvers do not 
respond within the review escalation period, then their appropriate designated escalation person 
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receives an email and can then accept or reject the package in the place of the original approvers. 
For details, see the “Routing Objects with Workflows” chapter in Getting Started with Agile PLM. 

Importing Product Information from Package 
Attachments 
If a package contains PDX, aXML or CSV (comma-delimited text) files describing Agile PLM 
objects, after the package is released (accepted), you can import the PDX, aXML or CSV 
information directly into your Agile PLM database. 

To import product information from package attachments: 

1.  Open the released package. 

2.  Display the Attachments tab. 

3.  Select a PDX, aXML or CSV attachment to import, and click Import. (You can import only one 
attachment at a time.) 

The Agile Web Client Import wizard opens, and the file you selected is specified as the file to 
import. You cannot specify a different file at this point. 

Follow the wizard steps to import the data. For more information about importing, see the Import 
and Export Guide. 

When the Import process is complete, you are returned to the Attachments tab of the package. 

Configuring Your Agile PLM System for Agile-to-Agile 
Communication 
To successfully publish content data from one Agile PLM system (the source Agile System) to 
another Agile PLM system (the target Agile System), the appropriate Agile Content Service settings 
and process extension settings must be defined. It can be done only by the Agile PLM 
administrator. 

For complete details, see the “Agile Content Service Settings” chapter in the Administrator Guide.

After Accepting/Rejecting Package Objects 

In cases where Agile ACS is used to automatically perform Agile-to-Agile communication, the 
source Agile PLM system can request a response from the target Agile PLM system. The required 
settings are defined by the Agile PLM administrators of each system. Depending on the settings, a 
response may be sent to the source Agile PLM system automatically (which requires no action on 
your part), or you may be required to send a response manually. (For information about how to set 
up package responses, see the “Agile Content Service Settings” chapter in the Administrator 
Guide.) 

If you are required to send a response manually, follow the instructions below. 

To send accept or reject responses manually in Java Client: 

1.  Open the package. 
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2.  Click the More button  at the top of the object window to display the More Actions menu 
and choose either Process Extensions > Accept Package Response or Process Extensions > Reject 
Package Response. 

Or, right-click in the window, and choose either Process Extensions > Accept Package Response or 
Process Extensions > Reject Package Response from the shortcut menu. 

Note The Process Extensions > Package Responses commands on the More Actions 
menu and the shortcut menu are available only if your Agile PLM administrator 
has enabled them. 

To send accept or reject responses manually in the Web Client 

1.  Open the package. 

2.  From the Actions menu, choose either Accept Package Response or Reject Package Response. 

Note The Package Response commands on the Actions menu are available only if your 
Agile PLM administrator has enabled them. 

 

About Searching for Packages 
If you have the appropriate privileges, you can search for Agile PLM packages the same way you 
search for any object in the Agile PLM database. For details, see Getting Started with Agile PLM. If 
you have questions about your privileges, see your Agile PLM administrator. 

The Searches folder includes a Content Manager Searches folder, which contains the Packages 
Submitted More Than X Hours Ago search and the CTOs Submitted More Than X Hours Ago 
search. 

Final Status of Packages 
Once a package has been reviewed and approved by the approvers and accepted by the content 
manager, the content manager can process the package data using the internal procedures specific 
to your company. Also, the content manager can import the package data content from other Agile 
PLM systems from the package object Attachments tab by using the Import button. (See Importing 
Product Information from Package Attachments (on page 27).) For example, the attachments on 
the package Attachments tab may become attachments for Agile PLM items in your Agile PLM 
database, or attachments that are PDX, aXML or CSV files could be imported into your Agile PLM 
database. 

The procedures used to process package data are unique to each company. Ask your Agile PLM 
administrator or your system administrator for information about how this task is performed at your 
company. 

When you have completed processing the package, the content manager can change its workflow 
status to the Closed status type by using either the Next Status button or Workflow tab. 
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Deleting Packages 
Agile Java Client and Web Client support “soft” and “hard” deletes. 

Note Caution! You cannot undelete a hard-deleted object. 

You can delete packages that meet the following criteria: 

 You created it; or you are the content manager, and your Agile PLM administrator has given 
content managers the appropriate privileges to delete a package. 

 The package is at the Pending status type or the Unassigned status. 

To soft-delete an unreleased package in Java Client: 

1.  Open the package that you want to delete. 

2.  Click the Delete button  in the package object window, and respond Yes to the confirmation 
prompt. 

The package is soft-deleted. It is no longer available for use. However, until it is hard-deleted, its 
number is reserved and cannot be reused. 

To soft-delete an unreleased package in Web Client: 

1.  Open the package that you want to delete. 

2.  Choose Actions > Delete, and respond OK to the confirmation prompt. 

The package is soft-deleted. It is no longer available for use. However, until it is hard-deleted, its 
number is reserved and cannot be reused. 

To hard-delete a soft-deleted package in Java Client (if you have the appropriate privileges): 

1.  From the Recycle Bin Searches folder, run the Deleted Packages search to locate the soft-
deleted package you want to hard-delete. 

2.  Open the package. 

3.  Click the Delete button  in the package object window, and respond Yes to the confirmation 
prompt. 

To hard-delete a soft-deleted package in Web Client (if you have the appropriate privileges): 

1.  From the Recycle Bin Searches folder, run the Deleted Packages search to locate the soft-
deleted package you want to hard-delete. 

2.  Open the package. 

3.  Choose Actions > Delete, and respond OK to the confirmation prompt. 
 

Undeleting Packages 

Since soft-deleted packages still exist in the database, you can undelete them if you have the 
necessary privilege. You can undelete packages associated with partners to which you are 
assigned. 
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To undelete a package in Java Client: 

1.  Find the soft-deleted package by running the Deleted Packages search in the Recycle Bin 
Searches folder. 

2.  Open the deleted package you want to restore. 

3.  To undelete the package, choose Edit > Undelete. 

The previously soft-deleted package is undeleted and is once more available to users. 

To undelete a package in Web Client: 

1.  Find the soft-deleted package by running the Deleted Packages search in the Recycle Bin 
Searches folder. 

2.  Open the deleted package you want to restore. 

3.  To undelete the package, choose Actions > Undelete. 

The previously soft-deleted package is undeleted and is once more available to users. 
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